Migrating Your IT Service Vision Environment from SAS Version 6 to SAS Version 8
The correct bibliographic citation for this manual is as follows: *Migrating Your IT Service Vision Environment from SAS Version 6 to SAS Version 8*. Cary, NC: SAS Institute Inc.

**Migrating Your IT Service Vision Environment from SAS Version 6 to SAS Version 8**

Copyright © 2003 by SAS Institute Inc., Cary, NC, USA

All rights reserved. Printed in the United States of America. No part of this publication may be reproduced, stored in a retrieval system, or transmitted, in any form or by any means, electronic, mechanical, photocopying, or otherwise, without the prior written permission of the publisher, SAS Institute Inc.

**U.S. Government Restricted Rights Notice:** Use, duplication, or disclosure of this software and related documentation by the U.S. government is subject to the Agreement with SAS Institute and the restrictions set forth in FAR 52.227-19, Commercial Computer Software-Restricted Rights (June 1987).


1st printing, February 2003

SAS Publishing provides a complete selection of books and electronic products to help customers use SAS software to its fullest potential. For more information about our e-books, e-learning products, CDs, and hardcopy books, visit the SAS Publishing Web site at support.sas.com/pubs or call 1-800-727-3228.

SAS® and all other SAS Institute Inc. product or service names are registered trademarks or trademarks of SAS Institute Inc. in the USA and other countries. ® indicates USA registration.

Other brand and product names are trademarks of their respective companies.
Migrating Your IT Service Vision Environment from SAS Version 6 to SAS Version 8

Introduction

This document is for sites at which IT Service Vision currently runs under SAS Version 6 but is migrating to run under SAS Version 8. You do not need this document if you are installing IT Service Vision for the first time or if you already migrated your IT Service Vision environment to SAS Version 8.

Introductory Notes

• The AIX Platform

If you are migrating from V6 to V8 on the AIX platform, see "Special Considerations for the AIX Platform" (at the end of this document) before continuing.

• Difference between Production Work and Non-Production Work

SAS V6 and V8 have different structures for objects. The objects need to be converted. In this document, "convert" means to create a V8 object that corresponds to a V6 object.

Before you use IT Service Vision software for production work under V8, you need to convert IT Service Vision objects to V8. You can use V6 objects for V8 non-production work as long as you use ACCESS=READONLY (for UNIX/Windows) or DISP=SHR (for OS/390) for V6 objects; however, we do not recommend reading V6 PDBs from V8.

• Supplied Software and Objects

Before you follow the rest of the instructions in this document, install IT Service Vision on V8. This installs the supplied software and supplied objects (already in their converted form). For more details, see the installation instructions.

• Site-Specific (Customized) Software and Objects

Now, the objects that are specific (customized) to you or your site (your SASUSER library, your site library/libraries, your PDBs, and so on) need to be converted.

Note: Convert the objects in the order in which they are presented below.

Your SASUSER Library

The first time that you use V8, it creates a V8 SASUSER library. The new library is empty.

Your Version 6 SASUSER library probably contains information that you would like to continue to use. The Version 6 library might contain information that is related to SAS settings. It might also contain information that is related to IT Service Vision settings, your list of known PDBs, your remote profiles, and perhaps your custom report definitions, custom rule definitions, custom palette definitions, and so on. Additionally, it might contain similar information about other SAS products.
Below are the instructions to copy the contents of the Version 6 library to the Version 8 library so that the Version 8 SASUSER library contains the Version 6 contents that have been structured correctly for Version 8. In the instructions, you have two decisions to make:

1. Decision 1: You can copy the contents by using the PROGRAM EDITOR window in the V8 GUI or by running the equivalent SAS batch job under V8. One of these methods might be more convenient than the other at your site.
2. Decision 2: You can copy the contents by using the EXCLUDE or SELECT statement.

- Using the EXCLUDE statement to copy the contents is recommended if you are using the V8 SASUSER library for the first time. You might copy more items than you need and thus be required to delete some items later, but you will be assured of copying all the items that you need.
- Using the SELECT statement to copy the contents is recommended if you have already used your V8 SASUSER library. You might not copy all the items that you need and thus be required to copy more items later, but you will not overwrite any items already in the V8 SASUSER library.

Read through all the instructions before acting on them, because the choices might make an important difference at your site.

1. Determine the location of your V6 SASUSER library and the names of the items in it. The easiest way to do this is to bring up IT Service Vision under V6 in your usual way, and submit the following statements from the SAS PROGRAM EDITOR window:

   Options: You can also submit this code in a V6 SAS batch job.

   OPTIONS SOURCE NOTES;
   LIBNAME SASUSER LIST;
   PROC DATASETS DD=SASUSER;
   RUN;
   QUIT;

   In the SAS log window, the location of your V6 SASUSER library is identified by the label Physical Name, and the items in your V6 SASUSER library are listed in the Name column.

2. Using a method that does not also invoke IT Service Vision (or that invokes IT Service Vision and then exits to SAS), invoke the V8 GUI. SAS defines the SASUSER libref to point to your V8 SASUSER library (and creates the library if this is your first use of V8).

3. In the PROGRAM EDITOR window of the V8 GUI, type the following code, edit the location of your V6 SASUSER library, and submit the edited code. Or else you can do the same thing in a SAS batch job under V8.

   At this point, choose whether you will copy with either the EXCLUDE statement instructions or the SELECT statement instructions.

   - To copy your library using the EXCLUDE statement (which copies everything except the item(s) listed in the EXCLUDE statement):

         ◊ For OS/390:

         LIBNAME olduser 'old_library_name'
         DISP=SHR;
PROC COPY IN=olduser OUT=sasuser;
EXCLUDE profile;
RUN;

where 'old_library_name' is the location of your V6 SASUSER library.

◊ For UNIX or Windows:

LIBNAME olduser 'old_library_name' ACCESS=READONLY;
PROC COPY IN=olduser OUT=sasuser;
EXCLUDE profile;
RUN;

where 'old_library_name' is the location of your V6 SASUSER library.

Note: The profile that is being excluded is your base SAS profile.

Note: If you use your V8 SASUSER library with other products or applications, some of the items that you copied might be associated with the other products and applications. Verify the correct operation of those products or applications after you copy the contents of the library.

♦ To copy your library using the SELECT statement (which copies only the item(s) listed in the SELECT statement):

◊ For OS/390:

LIBNAME olduser 'old_library_name' DISP=SHR;
PROC COPY IN=olduser OUT=sasuser;
SELECT cpusropt cpver itsv workarea tskinfo
cpupgms cpuout cpulog cpugseg cpusrc;
RUN;

where 'old_library_name' is the location of your V6 SASUSER library.

◊ For UNIX or Windows:

LIBNAME olduser 'old_library_name' ACCESS=READONLY;
PROC COPY IN=olduser OUT=sasuser;
SELECT cpusropt cpver itsv workarea tskinfo
cpupgms cpuout cpulog cpugseg cpusrc;
RUN;

where 'old_library_name' is the location of your V6 SASUSER library.

Note: The select list above contains the names of the items that IT Service Vision might have created in the V6 SASUSER library. Add to the select list the names of any objects that you created (report definition folders, rule definition folders, palette definition folders, data sets, views, catalogs, and so on) in the V6 SASUSER library and that you want to continue to use under V8. For example, if you have report definitions in SASUSER.MYDEFS, then add MYDEFS to the list. However, do not add your SAS base profile (PROFILE) to the list.

Note: Some of the items in the select list above might not be present in your V6 SASUSER library. Missing items are not a problem. You can omit them from the list or leave them in the list.

Note: If you use your V8 SASUSER library with other products or applications, then verify that those products or applications work properly after you finish copying. You might need to
Your Site Library/Libraries for IT Service Vision

Note: The instructions in this section offer some choices. Read through the entire section before acting on the instructions, so that your choices are consistent and are appropriate for your site.

When you install a new version or release of IT Service Vision, a new V8 site library is created. We strongly recommend that, at that point, you run CPSITEUP to merge the contents of your V6 production site library with the new V8 site library. CPSITEUP ensures that your existing production site library information will be retained; it also makes any updates in the new V8 site library available. If you have already run CPSITEUP, then you can skip the rest of this section. If you have not yet run CPSITEUP, then please review the following two sets of instructions that describe the different methods by which you might copy or merge your site libraries. We strongly recommend the use of CPSITEUP, but whichever method you choose, follow that method's instructions only.

If you have not run CPSITEUP but want to do so, then follow these instructions:

1. Locate and read the CPSITEUP member. You can find it
   - on OS/390, in the CPSITEUP member in the IT Service Vision PDS named CPMISC
   - on Windows, in the file named cpsiteup in the directory named !SASROOT\cpe\sasmisc
   - on UNIX, in the file named cpsiteup in the directory named !SASROOT/misc/cpe.
   
   2. Note: For customers who are running IT Service Vision 2.3 or 2.4:

      The CPSITEUP that ships with IT Service Vision 2.5 has a code change that you must make yourself if you are using the 2.3 or 2.4 version of CPSITEUP. So, if you are running 2.3 or 2.4, then locate CPSITEUP as described above and follow these instructions:

      1. In CPSITEUP, locate lines 273 and 274. In 2.3 and 2.4, those lines are

         %else
         %do;

      2. Expand those lines to be

         %else %if %quote(&PRODSITE) ne %quote(&NEWSITE)
         and
         %quote(&PRODSITE) ne %quote(&OLDSITE)
         %then
         %do;

      3. Execute the CPSITEUP code according to the instructions within it.

2. If you require multiple V8 libraries:

   1. on OS/390, allocate space for the additional site library (using the same values for the DSORG=, RECFM=, LRECL=, BLKSIZE=, and SPACE= parameters as the new V8 site library users). Then use the SAS COPY procedure (PROC COPY) to copy the contents of the new V8 site library to the additional site library.

   2. on Windows, create an additional folder, and copy the contents of the new V8 site library's folder to the additional folder.
on UNIX, create an additional directory, and copy the contents of the new V8 site library's directory to the additional directory.

If you have not run CPSITEUP and do not want to, then follow these instructions:

These instructions show how to copy the contents of a production V6 site library into the new V8 site library (or into a copy of the new V8 site library) so that the contents are structured correctly for V8. You can copy the contents by using the SAS V8 GUI or by running the equivalent SAS batch job under SAS V8. Because you are not using CPSITEUP, you will not be merging your production site library with any updates that might have been available in the new V8 site library.

1. Determine the location of your V6 site library. You can do this by invoking the IT Service Vision GUI under SAS V6, and using the Site Options button on the Administration tab in the UNIX/Windows GUI. You can also find the location by following this path in the OS/390 GUI:

From the main menu, select Options and Site SAS Options. Then select Site Location.

If in doubt, check with the IT Service Vision administrator at your site.

Then determine the location of your SAS V8 site library (or the location of a copy of the new SAS V8 site library). You can do this by invoking the IT Service Vision GUI under SAS V8, and using the method that is described in the previous paragraph. If in doubt, consult the IT Service Vision administrator at your site or the person who installed IT Service Vision.

2. Only for OS/390: Run IEFBR14 or use ISPF 3.2 to allocate space for a SAS V8 site library if the installation of IT Service Vision did not already do this. Except for using the DSN= and perhaps adding more space if the SAS V6 site library was running out of space, you can use the same amount of space and the same DCB= as for the SAS V6 site library.

3. Using a method that does not also invoke IT Service Vision, invoke the SAS V8 GUI. Or invoke IT Service Vision and exit to SAS. Or using a method that does not also invoke IT Service Vision, construct a batch job that invokes SAS V8.

4. Type the following code in the SAS PROGRAM EDITOR window, edit the location of your SAS V6 and SAS V8 site library for IT Service Vision, and submit the edited code. Or add the following code to the SAS job, edit the locations of your SAS V6 and SAS V8 site library for IT Service Vision, and submit the batch job with the edited code.

   For OS/390:

   ```sas
   LIBNAME OLDSITE 'old_library_name' DISP=SHR ;
   LIBNAME SITELIB 'new_library_name'
   DISP=OLD ;
   PROC COPY IN=oldsite OUT=sitelib ;
   RUN ;
   ```

   where 'old_library_name' is the location of your SAS V6 site library for the earlier release of IT Service Vision, and 'new_library_name' is the location of your SAS V8 site library for IT Service Vision.

   For UNIX or Windows:

   ```sas
   LIBNAME oldsite 'old_library_name' ACCESS=READONLY ;
   LIBNAME sitelib 'new_library_name' ;
   PROC COPY IN=oldsite OUT=sitelib ;
   RUN ;
   ```
where 'old_library_name' is the location of your SAS V6 site library for the earlier release of IT Service Vision, and 'new_library_name' is the location of your SAS V8 site library for IT Service Vision.

5. If you require multiple SAS V8 site libraries:

- on OS/390, allocate space for the additional site library (using the same values for the DSORG=, RECFM=, LRECL=, BLKSIZE=, and SPACE= parameters as the new SAS V8 site library uses). Then use the SAS COPY procedure (PROC COPY) to copy the contents of the new SAS V8 site library to the additional site library.
- on Windows, create an additional folder, and copy the contents of the new SAS V8 site library's folder to the additional folder.
- on UNIX, create an additional directory, and copy the contents of the new SAS V8 site library's directory to the additional directory.

Note: You might need to edit some of the values in the SAS V8 site library, but do not edit until you finish converting the other objects. Instructions for editing appear later in this document.

Your PDBs

You will need to make a new IT Service Vision PDB for use with V8 and then copy to it the contents of the V6 PDB. (If you have more than one IT Service Vision PDB, then you will need to do this one time for each PDB. However, you do not need to convert the demonstration PDBs. When IT Service Vision is installed, already-converted demonstration PDBs are available.)

Below are the instructions to create the V8 PDB and copy the contents of the V6 PDB to the V8 PDB so that they are structured correctly for V8. You can copy the contents by using the SAS V8 GUI with IT Service Vision. Or you can copy the contents by running a SAS batch job under SAS V8 and invoking IT Service Vision. Read through the instructions before acting on them, because the choice of method can make a difference. (For example, on OS/390, performing this operation in a batch job is strongly recommended.)

1. Determine the location of your V6 PDB. To remind yourself of the PDB locations, you can invoke the IT Service Vision GUI under SAS V6. Then, in the UNIX/Windows GUI select the Manage PDBs button on the Administration tab, or in the OS/390 GUI follow this path:

   From the main menu, select PDB Admin and then Manage PDBs/Switch PDB.

   If in doubt, consult the IT Service Vision administrator at your site.

   Then, plan the location of your V8 PDB. If in doubt, consult the IT Service Vision administrator at your site or the person who installed IT Service Vision.

2. On OS/390, allocate space for each of the PDB libraries. On UNIX and Windows, create a directory for the PDB and create subdirectories for each of the PDB libraries. There is no requirement at this point for any other structure or any content in the new PDB.

   - On an OS/390 server host:

     Use the OS/390 GUI (from the main menu, select PDB Admin and Define New PDB, and do not add tables). You can also accomplish this by running IEFBR14, or else by using ISPF 3.2 to allocate space for the V8 PDB libraries. Except for using the DSN= and perhaps adding more space if the V6 site library was running out of space, you can use the same amount of
space and the same DCB= as for the V6 PDB libraries. You will need to allocate nine libraries for each PDB, all of whose names start with the PDB name as a prefix. If your PDB name is MYPDB, for example, then you will need to allocate the following libraries:

◊ MYPDB.DICTLIB
◊ MYPDB.DETAIL
◊ MYPDB.DAY
◊ MYPDB.WEEK
◊ MYPDB.MONTH
◊ MYPDB.YEAR
◊ MYPDB.ADMIN
◊ MYPDB.PDBWORK
◊ MYPDB.COLLECT

A sample job to allocate a PDB is in the CMPDBALC member of the IT Service Vision CPMISC PDS. You might need to adjust the SPACE= parameters and possibly the UNIT= and BLKSIZE= parameters.

The requirements for allocating multivolume SAS data sets have changed in SAS V8. Refer to SAS V8 Online Documentation for further information.

On a UNIX or Windows server host:

In the next step, you will copy the contents of the V6 PDB to the V8 PDB. If you plan to do this in batch/background mode, in this step you must create directories for the V8 PDB and its libraries. If you plan to copy interactively, skip this step; you do not need to pre-allocate the directories.

You can create directories in any of these ways:

◊ use the UNIX/Windows GUI (from the main window, select the QuickStart Wizard or the Create PDB Wizard)
◊ use the IT Service Vision %CPSTART macro in a SAS batch job
◊ use the mkdir command at the operating system prompt.

If you want your PDB to have a name like /my/pdb (on UNIX) or c:\My\Pdb (on Windows), for example, then you will need to create the following directories:

◊ /my/pdb or c:\My\Pdb
◊ /my/pdb/dictlib or c:\My\Pdb\Dictlib
◊ /my/pdb/detail or c:\My\Pdb\Detail
◊ /my/pdb/day or c:\My\Pdb\Day
◊ /my/pdb/week or c:\My\Pdb\Week
◊ /my/pdb/month or c:\My\Pdb\Month
◊ /my/pdb/year or c:\My\Pdb\Year
◊ /my/pdb/admin or c:\My\Pdb\Admin
◊ /my/pdb/pdbwork or c:\My\Pdb\Pdbwork
◊ /my/pdb/collect or c:\My\Pdb\Collect

3. Copy the contents of the V6 PDB to the V8 PDB.

♦ Using the GUI:
If the V8 GUI is not already invoked, invoke it. Then, invoke IT Service Vision software with one of the SAS V8 demonstration PDBs as the active PDB.

◊ If the PDB to be converted is on an OS/390 server:

Follow this path from the main menu: Select PDB Admin and then select Manage PDBs/Switch PDBs. Select the name of the V6 PDB from the ItemActions menu and then select Copy PDB. Type or select the location of the V8 PDB and select Run.

When the confirmation dialog box appears, select OK. When the copying is finished, select Goback to return to the PDB Admin window. From the list of known PDBs, select the name of the V6 PDB. From the ItemActions menu, select Remove PDB Entry.

Note: The batch method of copying the PDB is preferred, because copying the PDB in a TSO session can take a very long time.

◊ If the PDB to be converted is on a UNIX or Windows server:

From the Administration tab, select Manage PDBs. From the list of known PDBs, select the name of the V6 PDB. Then, from the File menu, select Copy. In the To field, type or select the name of the V8 PDB and select OK. When the copying is finished, from the list of known PDBs, select the name of the V6 PDB. From the File menu, select Remove PDB Entry.

Note: The above OS/390 and UNIX/Windows paragraphs assume that you retained the original name and location for the V6 PDB and used a new name and location for the V8 PDB. If instead you renamed and moved the V6 PDB and if you used the original name and location for the V8 PDB, then you do not need to remove the original name from your V8 list of known PDBs. However, you might want to change the name of the V6 PDB in your V6 list of known PDBs, V6 remote profiles, and so on.

♦ Using a batch job:

If a batch job that invokes SAS V8 has not already been constructed, construct one now. (On UNIX and Windows, be sure that the invocation uses your V8 SASUSER library.) Then, add a call to the %CPSTART macro to invoke IT Service Vision software with one of the V8 demonstration PDBs as the active PDB. Add a call to the %CPDBCOPY macro to copy the contents of the V6 PDB to the V8 PDB, and add a call to the %CPSTART macro to activate the V8 PDB.

Note that in the first call to the %CPSTART macro, you need to specify the ROOT= parameter so that it can point to the location of the IT Service Vision software. Here are two examples:

◊ If the PDB to be converted is on an OS/390 server:

```sas
%cpstart(mode=batch,  
   root=location-of-IT-Service-Vision,  
   pdb=location-of-SASV8-demonstration-PDB,  
   disp=shr) ;  
%cpdbcopy(location-of-SASV6-PDB,location-of-SASV8-PDB);  
%cpstart(mode=batch,  
```
If the PDB to be converted is on a UNIX or Windows server:

Note: For Windows: Before running the following code, check that you do not have the PDB directory or its subdirectories locked. That is, make sure that the cd command (or Windows Explorer or My Computer) is not set to the PDB directory or to any of its subdirectories.

%cpstart (mode=batch, root=location-of-IT-Service-Vision, pdb=location-of-SASV8-demonstration-PDB, access=readonly);
%cpdbcopy (location-of-SASV6-PDB, location-of-SASV8-PDB);
%cpstart (mode=batch, root=location-of-IT-Service-Vision, pdb=location-of-SASV8-PDB, access=write);

If you use the IT Service Vision GUI, check that your V8 list of known PDBs has the appropriate names and locations, and update any that need to be changed. You might want to do the same for your V6 list of known PDBs. Access and, if necessary, edit your list of known PDBs as described above. (In the section "Your PDBs," see step 3.) For more information about calling these macros, see the Macro Reference: Table of Contents.

4. Your site might have a .QS PDS or /qs directory "under" your PDB. That PDS or directory is not a SAS object and its related PDSs and subdirectories are not SAS objects. If you want to make a copy of them "under" the V8 PDB, then you can use an operating system command.

For example:

- On OS/390, you can use ISPF 3.3 or IEBCOPY in batch or you can use a similar utility. There are multiple PDSs with a QS qualifier. Make sure that you copy each of them.
- On Windows, you can use Windows Explorer or you can use XCOPY or a similar command.
- On UNIX, you can use

```
cp -R location-of-SASV6-PDB/qs location-of-SASV8-PDB/qs
```

Also, if you want to use the QuickStart jobs with the V8 PDB, then you will need to edit the xREPORT, xPROCESS, and possibly xFTPHTML files in the 'location-of-SASV8-PDB/qs/cntl' or 'location-of-SASV8-PDB\qs\cntl' directory or in the 'location-of-SASV8-PDB.QS.CNTL' PDS, and change the values of the PDB= and ROOT= parameters that are contained in those files.

5. Your site might have an archive "under" or associated with your PDB. An archive is used only in read mode and thus its archive libraries do not require conversion. (If you need to restore data from these archive libraries later, then you will need to remember their original names and locations.)

MXG

If you install a new version of MXG, then part of the installation procedure is to run a job that creates and populates a SAS library of formats for use with MXG. When you run the job under SAS V8, a V8 library will be the result.

If you want to continue to use your existing (SAS V6) format library until you install the next version of
MXG, then you can convert the existing format library from V6 to V8. First, allocate space for the new library, as described in the section Your Site Library/Libraries for IT Service Vision. Then, to copy the catalog that contains the formats, submit SAS code like this through the SAS PROGRAM EDITOR window or by using a SAS batch job:

```
LIBNAME SASV6LIB 'location−of−SASV6−format−library−for−MXG'
   DISP=SHR ;
LIBNAME SASV8LIB 'location−of−SASV8−format−library−for−MXG'
   DISP=OLD ;
PROC CATALOG CAT=SASV6LIB.FORMATS ;
COPY OUT=SASV8LIB.FORMATS ;
RUN ;
QUIT ;
```

Other Libraries Related to IT Service Vision

You might have other V6 libraries that are related to IT Service Vision, such as one or more libraries for custom report definitions, custom rule definitions, custom palette definitions, and source code for exits.

Convert each of these libraries in the same way that you converted the site library. However, for clarity you might want to use different librefs. For example, instead of oldsite you might want to use oldlib, and instead of sitelib you might want to use newlib. And the locations that you edit are the locations of the old and new custom library, not the old and new site library.

Your DeskTop Reporter

The DeskTop Reporter, as shipped with IT Service Vision, is already converted.

If the only customization or modification that you have made to your reports is to use your own data, then you need to convert the job that contains the call to the %CPEISSUM macro. To convert the job, follow the instructions below, in "Your Batch Jobs, Scripts, CLISTS, and So On."

If you have added new reports or modified existing reports by using SAS/EIS software, then follow the instructions in the section "Additional Tasks to Consider for DeskTop Reporter" to convert.

Remote Profiles

If you use any remote profiles, then edit the locations in them to refer to the V8 objects. To do this, you can follow these steps:

1. From the Administration tab, select Manage PDBs Locals Remote Profile.
2. Then, for each profile that you use, select the profile name and then select File Open.
3. Review the contents of all fields on all of the tabs, and edit the values for any software or objects whose location has changed.
4. Then select OK OK Close.

Note: These instructions assume that the original names and locations were retained for the V6 objects and new names and locations were used for the V8 objects. If instead the V6 objects were renamed and moved and the V8 objects used the original names and locations, then you do not need to edit your V8 remote profiles.
However, you might want to edit the V6 remote profiles.

PDB Properties

If you have a PDB that has an archive, then decide whether you want the V8 PDB to use the same archive as the V6 PDB or to use a new archive. (Either location is acceptable.) Then, edit those properties of the V8 PDB that refer to the location of the archive. (If nothing was specified, then the location of the archive is probably changing, because the default location is "under the PDB" and the location of the PDB is probably changing.)

- To edit in batch:
  Call the %CPSTART macro to activate that PDB. Then, call the %CPPDBOPT macro to specify the values of its archive parameters.
- To edit by using the OS/390 GUI:
  Activate that PDB and then, on the main menu, select PDB Admin Set Active PDB Options. Then, edit the values of the archive parameters and select OK.
- To edit by using the UNIX/Windows GUI:
  From the Applications tab, select Manage PDBs. Activate the PDB if it is not already activated, and then select Properties and the Archive tab. Then, edit the values of the archive parameters, and select OK and then Close.

Your List of Known PDBs

If you use the IT Service Vision GUI, then edit your list of known PDBs if you are on a client host. For instructions, see step 3 in the section "Your PDBs."

Your Batch Jobs, Scripts, CLISTs, and So On

If you have one or more batch jobs, then save a V6 version of the job and edit one of the copies to refer to the locations of the IT Service Vision software and the V8 versions of the objects. Also make the following changes where you invoke SAS:

- On OS/390:
  - In SAS V6, where you used the CONFIG file in
    CPMISC(CMCONFIG)
    for SAS V8, instead use the one in
    CPMISC(CMCONFI8)
  - In SAS V6, where you used, in your own custom SAS code,
    ERRORABEND
    for SAS V8, because SAS stops on more conditions, you might instead want to use
• On UNIX:
  ♦ In SAS V6, where you used the options

    -dmsbatch, -batch, -terminal, and -fsdevice ascii.vt100

  for SAS V8, remove those options and instead add the option

    -nterminal

• On Windows:

  ♦ In SAS V6, where you used the option

    -dmsbatch

  for SAS V8, remove that option and instead add the option

    -nterminal

Similarly, save and then edit one of the copies of scripts, CLISTs, and any other such files that refer to locations of the software and objects.

---

Your PGMLIB

Note: The following paragraphs describe the same operation that you perform with every new PGMLIB if you have an installed user-written table in the earlier PGMLIB. The operation is not related to the conversion from V6 to V8.

IT Service Vision includes a V8 PGMLIB. If you installed a user-written table definition in your V6 PGMLIB, then you might want to install that table definition in your V8 PGMLIB.

To do so, write a batch job that does all of the following:

- invokes SAS V8
- calls the %CPSTART macro to start IT Service Vision and to activate a PDB that contains the table
- then calls the %CPDDUTL macro to apply the INSTALL TABLE control statement. (For more information about using the %CPDDUTL macro and about the %CPDDUTL control statement INSTALL TABLE, see Using the %CPDDUTL Macro.)

Verifying

Ideally, run both the V6 and V8 systems in parallel for two weeks and compare the results each day. If you have a very large site, running in parallel might not be possible, but you should at least run parallel test systems before converting the production system to V8.

At minimum, compare the process summary table and reduce summary table in the V6 and V8 logs.
Additional Tasks to Consider for DeskTop Reporter

The following instructions describe how to update your DeskTop Reporter if you have added or modified reports (other than modifying reports to use your own data).

Data Conversion

Data can be converted from V6 to V8 by using the SAS COPY procedure (PROC COPY) with the appropriate library engines. You can submit the following SAS code:

- For OS/390:

  ```sas
  LIBNAME SASV6Data SASV6 'SASV6 path' DISP=SHR ;
  LIBNAME SASV8Data SASV8 'SASV8 path' DISP=OLD ;
  PROC COPY IN=SASV6Data OUT=SASV8Data
    MEMTYPE=(DATA MDDB VIEW) ;
  RUN ;
  ```

- For UNIX and Windows:

  ```sas
  LIBNAME SASV6Data SASV6 'SASV6 path' ACCESS=READONLY ;
  LIBNAME SASV8Data SASV8 'SASV8 path' ;
  PROC COPY IN=SASV6Data OUT=SASV8Data
    MEMTYPE=(DATA MDDB VIEW) ;
  RUN ;
  ```

Note: Views do not need to be re-created from the source code. The VIEW member can be copied by using PROC COPY. It is recommended that you keep the source code in any case.

SAS V8 Repositories

In V8, metadata is stored in repositories, not in libraries. When you are migrating the metabase, the repository name in V8 should be the same as the metabase libname in V6. If they are not the same, then the applications that use the metabase definitions will be unable to find them, and most of the attributes will need to be set up again.

Note: Repository names are case sensitive. Always use uppercase for repository names that are the target of V6 conversions.

Creating a repository:

1. Type REPOSOMGR on the command line and select Enter or Return.
2. Select the Repository Registration.
3. Select the New button.
4. Type the repository name (in uppercase for V6 conversions), path, and description.

Note: Repositories will be created for you for each V6 metabase during Metabase Conversion.
**Metabase Conversion**

This section covers only non–HOLAP entries in the metabase. The metabase libraries can be converted from the V6 libraries to the V8 repository paths by using the SAS COPY procedure (PROC COPY). You can submit the following SAS code:

- For OS/390:
  
  ```sas
  LIBNAME SASV6MetLib SASV6 'SASV6 path' DISP=SHR ;
  LIBNAME SASV8RepLib SASV8 'SASV8 path' DISP=OLD ;
  PROC COPY IN=SASV6metlib OUT=SASV8RepLib ;
  SELECT metabase1 metabase2 . . . sasmbc sasmbi ;
  RUN ;
  ```

- For UNIX and Windows:
  
  ```sas
  LIBNAME SASV6MetLib SASV6 'SASV6 path' ACCESS=READONLY ;
  LIBNAME SASV8RepLib SASV8 'SASV8 path' ;
  PROC COPY IN=SASV6metlib OUT=SASV8RepLib ;
  SELECT metabase1 metabase2 . . . sasmbc sasmbi ;
  RUN ;
  ```

The metabase is now in V8 file format, but the internal structure of the metabase needs to be converted to a repository structure.

To convert the metadata:

1. Open the Metabase window in SAS/EIS.
2. Select Edit → Convert.
3. From the list, select the repository path to which you copied your V6 metabase.
4. Add your metabases to the selected list.
5. Select OK to perform the conversion.

**Application Conversion**

Applications can be converted by using the SAS COPY procedure (PROC COPY). You can submit the following SAS code:

- For OS/390:
  
  ```sas
  LIBNAME SASV6AppLib SASV6 'SASV6 Path' DISP=SHR ;
  LIBNAME SASV8AppLib SASV8 'SASV8 Path' DISP=OLD ;
  PROC COPY IN=SASV6AppLib OUT=SASV8AppLib ;
  SELECT SASV6ApplDB ;
  RUN ;
  ```

- For UNIX and Windows:
  
  ```sas
  LIBNAME SASV6AppLib SASV6 'SASV6 Path' ACCESS=READONLY ;
  LIBNAME SASV8AppLib SASV8 'SASV8 Path' ;
  PROC COPY IN=SASV6AppLib OUT=SASV8AppLib ;
  SELECT SASV6ApplDB ;
  RUN ;
  ```
Individual applications will work if the libname that is used in V8 is not the same as that used in V6. However, application windows will be unable to find the applications unless they are referenced by the same libref as they were in V6. Therefore, always keep the libref the same.

Mixing V6 and V8 Objects

Both SAS V6 applications that are ported to V8 and native V8 objects can be mixed on the same application window.

Special Considerations for the AIX Platform

You cannot use the SAS COPY procedure (PROC COPY) to copy SAS V6 catalogs on AIX to SAS V8 catalogs. Thus, as you follow the procedures that are outlined in this document, you might see error messages similar to the following:

ERROR: File format version 6 catalogs are not supported by this release.

ERROR: File TDICTIONARY.CPFMTS.CATALOG has not been saved because copy could not be completed.

You might also see these error messages when running %CPDBCOPY, because this macro also uses the SAS COPY procedure.

If, based on the information in this migration document, you decide that it is necessary to migrate the catalog(s), or if the instructions state that the catalog(s) must be migrated, then you must do the following:

- Use the SAS CPORT procedure (PROC CPORT) on SAS V6 to convert the catalog(s) into transport file format.
- Then, use the SAS CIMPORT procedure (PROC CIMPORT) on SAS V8 to add the catalog(s) to a SAS V8 library.
- For example, first edit the following code and submit it on your SAS V6 system to create a transport file that contains the necessary catalogs. (The example below adds two SAS catalogs, CPFMTS and CPVER, to the transport file. You can include additional catalogs in the SELECT statement as necessary.)

LIBNAME SASV6LIB 'SASV6_library' ;
PROC CPORT LIB=SASV6LIB FILE='location-of-external-file' ;
SELECT CPFMTS CPVER ;
QUIT ;

where 'SASV6_library' is the location of the SAS V6 library that contains the catalogs to be ported.
- Next, if you need to FTP the transport file, then you should ensure that it is transferred in binary mode.
- Finally, you need to import the catalogs in the transport file to your SAS V8 system. Edit the following code and submit it on your SAS V8 system:

LIBNAME SASV8LIB 'SASV8_library_name' ;
PROC CPORT LIB=SASV8LIB INFILE='location-of-external-file' ;
QUIT ;

where 'SASV8_library_name' is the location of the SAS V8 library to contain catalogs.
Note: For further information about the SAS CPORT and SAS CIMPORT procedures, refer to your SAS System documentation.